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Use the online help for in-depth information not given in this Quick 
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• Select either Contents, Index, or Search from the Personal 
Compound Database software Help menu.

• Press the F1 key to get more information about a window, tab, or 
dialog box.
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What is Personal Compound Database software?

MassHunter Personal Compound Database provides tools to access a master 
pesticide database for compound searches based on LC/MS data.

Personal Compound Database software allows you to:

• Do automated searches on multiple compounds, which saves time.

• Do private, on-site searches, which keeps intellectual property safe.

• Customize the database by adding proprietary compounds.

• Customize the database by adding retention times to compounds in the 
database.

• Search a database using mass only, mass and optional retention time, or mass 
and retention time required. The use of retention time increases the compound 
identification specificity.

• Search on text.

• Search on empirical formula.

• Search on retention time.

• Do automated or manual searches from Agilent MassHunter Workstation 
Software–Qualitative Analysis program. See page 11.

• Link to websites for more information on many compounds.

Personal Compound Database software supports mass lists output from Agilent 
MassHunter Mass Profiler, GeneSpring MS, and Qualitative Analysis software.
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Installation

If the MassHunter Personal Compound Database is not already installed on your 
system, install it as follows.
1 Insert the CD-ROM labeled Agilent G6854AA into the CDROM drive.
2 Click the Windows Start button and select Run.
3 Type x:\setup, where x is the letter of the CDROM drive, and click OK.
4 Follow the instructions on the screen to install the software.

To uninstall the software

Use the Add/Remove window of the Control Panel.

Startup

Select Programs > Agilent > MassHunter Workstation > Personal Compound 
Database from the Windows Start menu, as shown below, to start the MassHunter 
Personal Compound Database software.
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Main Window

The MassHunter Personal Compound Database main window has the following 
areas and controls.

• “Toolbar”(below)

• “Menus” (below)

• “Tabs” on page 7

• “Search Results Table” on page 8

• “Structures” on page 9

Toolbar

The following items are available on the MassHunter Personal Compound 
Database toolbar:

Menus

The following menus are available in MassHunter Personal Compound Database 
software:

• “File menu” on page 5

• “Edit menu” on page 5

• “View menu” on page 6

• “Database menu” on page 6

• “Links menu” on page 6

• “Help menu” on page 7

Button Equivalent Menu Item

Database > Find Compounds

File > Print Results

File > Export Results

File > New Database

File > Open Database

Help > Contents
4 Personal Compound Database Quick Start Guide



File menu

New Database Allows you to create a subset of the master Pesticide database or 
to create a custom database that can be edited and personalized for your lab. This 
is done by creating a copy of an existing database with a new name.

Open Database Allows you to open a different database.

Backup Database Allows you to copy the database for archive purposes.

Import Compounds  Allows you to select a file that contains compounds to add to 
a custom database if editing is enabled. If you start with an empty database, then 
you are essentially creating a custom database from the imported compounds.

Export Results Allows you to export batch summary results for use with other 
programs, such as spreadsheets and word processors.

Print Results  Allows you to print search results and structures.

Exit Closes the Personal Compound Database software window.

Edit menu 

These menu items are for use with custom databases with editing enabled only 
and are only available when the Edit Compounds tab is displayed.

Add New Creates a new compound in the database with a mass of 0 named “New 
Compound”. The new compound is displayed at the end of the Results table. Enter 
information such as RT, Formula, Name, and Structure for the new compound in 
the Edit Compounds tab.

Save As New Creates a new compound in the database using the current values 
of the edit fields on the Edit Compounds tab. The new compound is displayed at 
the end of the Results table.

Update Selected Updates the information for the selected compound in the 
database. The updated information is reflected in the Results table.

Delete Selected Removes the selected lines of the Results table, which removes 
the selected compounds from the database. Use Ctrl+click or Shift+click to select 
multiple lines.
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View menu

Add/Remove Columns Opens the Add/Remove Columns dialog box, which allows 
you to specify what information is displayed in the Search Results table.

Restore to Default Columns Displays the columns in the Search Results table as 
they were originally set in the software.

Structure Details Opens the Structure Details dialog box, which displays the 
current structure in a larger size for easier viewing.

Database menu 

Find Compounds Searches the database for compounds that match criteria 
specified on the Single Search tab or Batch Search tab. Compounds that match the 
search criteria are displayed in the Search Results table at the bottom of the 
window.

Allow Editing A toggle that enables or disables editing operations to a custom 
database. The master Pesticides database cannot be edited.

Database Information Allows you to view information about the current database 
and edit the description for custom databases with editing enabled.

Links menu 

Allows you to access the following websites for information on compounds: 

• PubChem (National Center for Biotechnology Information) 

• Chem Industry

• Compendium of Pesticides

• EPA - Pesticides (Environmental Protection Agency)

• NPIC (National Pesticide Information Center)

• NIH NLM (National Institute of Health – National Library of Medicine)

• TOXNET

• PAN Database

• WHO - Pesticides (World Health Organization)
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Help menu

Contents, Index, and Search Opens the online help window for Personal 
Compound Database software, with the appropriate tab displayed.

View EULA Displays the license agreement for Personal Compound Database 
software in a Notepad window.

About Displays the version and build number of the Personal Compound 
Database software.

Tabs

Single Search tab

Allows you to search for compounds in the database. The search is started by 
clicking the Find Compounds button on the toolbar, selecting Find Compounds 
from the Database menu, or pressing the F5 key. Search results are displayed in the 
Results table in the lower part of the window. See “To find compounds” on page 12.

Batch Search tab

Allows you to search for compounds in the database by specifying a mass list and 
optional retention times. The search is started by clicking the Find Compounds 
button on the toolbar, selecting Find Compounds from the Database menu, or 
pressing the F5 key. Search results are displayed in the Results table in the lower 
part of the window. See “To find compounds from a mass list” on page 16.

Batch Summary tab

Shows a summary view of all Best fit hits from a Batch Search. Results can be 
exported for use with other applications. You can also add comments and update 
retention times for custom databases with editing enabled. See “To view batch 
summary results” on page 19.

Edit Compounds tab

For custom databases that allow editing, you can use this tab to edit information 
for compounds and to add new compounds. Before editing existing compounds, do 
a Single or Batch search, so that the compounds to be modified are present in the 
Search Results table. See “To edit a custom database” on page 23.
Personal Compound Database Quick Start Guide 7



Search Results Table

This area in the lower part of the Personal Compound Database software window 
allows you to view search results. It also allows you to select compounds for 
editing on the Edit Compounds tab (custom databases with editing enabled only).

Viewing search results

Clicking on a row of the table displays structure information about that compound 
in the Structures area, if the structure is available in the database.

• To change which columns of information are displayed in the table, right-click 
in the table and select Add/Remove Columns from the shortcut menu.

• To sort the table by the entries in a column, click the heading for the column of 
interest.

• To change the order of the columns of information in the table, drag a column 
heading to a different position. Repeat this until the desired order is achieved.

• To resize a column to fit the information contained in it, double-click on the 
right column divider in the heading of the column of interest.

• To resize a column to a specific width, drag the separator between the column 
headings to the right or left until the column is the desired width.

Editing compound information in the database

You can edit information in the database for the compounds shown in the Search 
Results table as follows, if you are using a custom database with editing enabled.

• Select the row (compound) of interest in the table. Make changes to the values 
in the edit fields that appear in the Edit Compounds tab. When you click the 
Update Selected button, the database is updated and the changes are reflected 
in the results table.

• Add a compound to a custom database in either of the following ways:

• Add New - Click the Add New button to create a new compound in the 
database with a mass of 0 named “New Compound”. The new compound is 
displayed at the end of the Results table. Enter information such as Mass, RT, 
Formula, Name, and Structure for the new compound in the Edit Compounds 
tab. The information for the new compound is updated in the database and 
reflected in the results table when you click the Update Selected button.

• Save As New - Click the Save As New button to create a new compound in 
the database using the current values of the edit fields on the Edit 
Compounds tab. The new compound is displayed at the end of the Results 
table.
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• To remove a compound from the database, select the row (compound) of 
interest in the table, then click the Delete Selected button. Use Ctrl+click or 
Shift+click to select multiple lines for deletion.

Structures 

Structure tab 

This area on the right side of the Personal Compound Database software window 
displays structure information for the compound currently selected in the Results 
table, if it is available in the database. Clicking the  button opens the 
Structure Details dialog box and displays a larger image of the structure.

MOL Text tab 

Displays the text version of the structure. If the current database is a custom 
database with editing enabled, you can copy text from a molecular drawing tool 
that is capable of generating MOL file text and paste it into this area to update the 
structure of the selected compound. Or you can use the  button in the 
Structure area to load a structure from a .MOL file. The Structure  button is 
available on the Edit Compounds tab only.
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Getting Started

The following topics will help you get started with Agilent MassHunter Personal 
Compound Database. This guide and the online help explain these activities.

• “Searching a PCD database in Qualitative Analysis” on page 11

• “Searching a database in Personal Compound Database software” on page 12

• “Doing a batch search” on page 16

• “Database operations” on page 21

• “Custom database operations” on page 23
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Searching a PCD database in Qualitative Analysis

Use the following procedures to search a PCD database with MassHunter 
Workstation Software–Qualitative Analysis program. These steps apply to version 
B.02.00 of Qualitative Analysis and may be slightly different in later revisions.

To use a PCD database to identify compounds in Qualitative Analysis

Use this procedure to identify compounds with a PCD database:
1 Open the data file of interest in Qualitative Analysis.
2 Find compounds as described in Qualitative Analysis online help.
3 Select the compounds to search in the Compound List window or Data 

Navigator.
4 Set the database search criteria in the Identify Compounds > Search Database 

section of Method Editor:

a On the Search Criteria tab, select Mass as the Values to match option.

b On the Database tab, click the Browse […] button to open the Open Database 
File dialog box.

• Select File Type .mtl to see a list of PCD databases.

• Select the PCD database of interest.
5 Initiate the search and review the results in the DB Search Results window.

To use a PCD database to identify spectrum peaks in Qualitative Analysis

Use this procedure to identify spectrum peaks with a PCD database:
1 Open the data file of interest in Qualitative Analysis.
2 Extract a mass spectrum or extract a peak spectrum as described in Qualitative 

Analysis online help.
3 If not already set, set the database search criteria in the Identify Compounds > 

Search Database section of Method Editor as described in Step 4 above.
4 Initiate the search by right-clicking on the spectrum and selecting Search 

Database for Spectrum Peaks from the shortcut menu (or in other ways 
described in Qualitative Analysis online help).
The database is searched for the masses in the spectrum. If hits are found for 
the masses, information such as masses, formulas, and compound names is 
displayed in the DB Search Results window. 

5 Review the results in the DB Search Results window.
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Searching a database in Personal Compound Database software

Searching a PCD database for compounds matching certain criteria can be broken 
into the following activities, which are described in the following pages:

• “To find compounds” (below)

• “To view search results” on page 14

• “To change how data is displayed in the Results table” on page 14

• “To print search results” on page 15

To find compounds

1 If the database you want to search is not already open, open it in either of the 
following ways:

• Select Open Database from the File menu, or 

• Click the  button on the toolbar.
2 Click on the Single Search tab.
3 To return the contents of the entire database, leave the search fields blank and 

skip to Step 7. Otherwise, set the desired mass search criteria:

a Mass and Mass tolerance in ppm or mDa

b Type of mass ([M+H]+, Neutral, or [M-H]-)

• Select [M+H]+ mass type if you are searching for an observed positive ion in 
the database. The neutral mass value will be automatically calculated, 
assuming the ion was a positive protonated ion. If Include cations is selected 
in Step 3c, the neutral mass of a radical cation is calculated. Only those 
compounds that have been defined as cations in the database will be 
compared to the calculated neutral mass of a radical cation.

• Select Neutral if the mass is the calculated neutral mass value, usually a 
value that was calculated by Molecular Feature Extraction (MFE) software. 
Do not select this value for a mass observed in a spectrum. Ions observed in 
a spectrum have a charge and need to be converted to neutral to work with 
the database. For observed ions use either the [M+H]+ or [M-H]- selection. If 
Neutral is selected, you can choose Include anions or Include cations for 
the Radical ion search mode setting in Step 3c.
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• Select [M-H]- mass type if you are searching for an observed negative ion in 
the database. The neutral mass value will be automatically calculated, 
assuming the ion was a negative deprotonated ion. If Include anions is 
selected in Step 3c, the neutral mass of a radical anion is calculated. Only 
those compounds that have been defined as anions in the database will be 
compared to the calculated neutral mass of a radical anion. 

c Radical ion search mode:

• Include neutrals is normally always selected. Clear it if you want to search 
radical ions only.

• If you selected Neutral for the mass type in Step 3, then select Include 
anions or Include cations if you also want to consider those chemicals that 
don't pick up or lose a proton to ionize. Searching both modes will return 
false matches. 

• Choose Include anions if the data was acquired in negative ion mode.

• Choose Include cations if the data was acquired in positive ion mode. 
4 When searching the master Pesticides database or a custom database without 

retention time data, be sure to clear the Require checkbox for Retention time. 
When searching a database that contains retention time information for 
compounds, enter a retention time and RT tolerance if you want to consider 
retention times in the search.

5 If desired, enter a Formula, Name, or CAS ID to find compounds based on 
these fields. You can also enter text in the Notes field to search for a text string, 
such as “phenylurea”.

6 Initiate the search in any of the following ways: 

• Click the Find Compounds button on the toolbar, 

• Select Find Compounds from the Database menu, or 

• Press the F5 key. 
7 View search results in the Search Results table at the bottom of the window. For 

more information, see “To view search results” on page 14 and “To change how 
data is displayed in the Results table” on page 14.
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To view search results

1 Do a search on the Single Search tab as described in “To find compounds” on 
page 12.

2 View search results in the Search Results table at the bottom of the window. You 
can change how search results are displayed as described in “To change how 
data is displayed in the Results table” on page 14.

3 Click on a compound in the Results table to view its structure information in 
the Structures area on the right side of the window, if the structure is available 
in the database.

4 Click on the Edit Compounds tab to edit information for custom databases that 
allow editing, as described in “To edit a custom database” on page 23.

5 To print results, see “To print search results” on page 15.

To change how data is displayed in the Results table

This topic relates to search results displayed on the Single Search, Batch Search, 
Batch Summary, and Edit Compounds tabs.
1 To sort the table by the entries in a column, click the heading for the column of 

interest.
2 To change the order of the columns of information in the table, drag a column 

heading to a different position. Repeat this until the desired order is achieved.
3 To resize a column to fit the information contained in it, double-click on the 

right column divider in the heading of the column of interest.
4 To resize a column to a specific width, drag the separator between the column 

headings to the right or left until the column is the desired width.
5 To change which columns of information are displayed in the table:

a Right-click in the table and select Add/Remove Columns from the shortcut 
menu to open the Add/Remove Columns dialog box.

b Move the items of information that you want to display into the Show these 
columns list.

c Click OK.
The Results table will be updated to reflect the selected columns of information.
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To print search results

Results can be printed from the Single Search, Batch Search, Batch Summary, and 
Edit Compounds tabs.
1 If you want to print only certain compounds, highlight those rows in the Results 

table using Ctrl+click or Shift+click.
2 Open the Print Results dialog box in any of the following ways:

• Select Print Results from the File menu.

• Click the  button on the toolbar.

• Right-click in the results table and select Print Results from the shortcut 
menu.

3 Select desired report options from the following:

• Printer (destination)

• Print Preview if you want to view the report on the screen first.

• Fit to page to size the report to fit the width of the page.

• Orientation (Landscape or Portrait). The default is Landscape, as it allows 
more columns of information.

4 Select the desired report content options from the following: 

• All rows or Only highlighted rows of the results table 

• Include search parameters 

• Include unmatched masses 

• Print structures and the size (240 x 160, 360 x 240, or 540 x 360)
5 Click OK to generate the report. 

If you selected Print Preview in Step 3, review the report in the Print preview 
pane. Click the  button on the toolbar to print the report. 

NOTE For Single Search, only the first 30 compound results will be printed.
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Doing a batch search

Searching a database for compounds based on a mass list can be broken into the 
following activities, which are described in the following pages:

• “To find compounds from a mass list” (below)

• “To view batch search results” on page 18

• “To view batch summary results” on page 19

• “To export batch summary results” on page 20

To find compounds from a mass list

1 If the database you want to search is not already open, open it in either of the 
following ways:

• Select Open Database from the File menu.

• Click the  button on the toolbar.
2 Click on the Batch Search tab.
3 Enter a mass list in one of the following ways: 

• Click the File button to the left of the mass list table to open a mass list file 
output by MassHunter Qualitative Analysis (.csv or .txt file), Mass Profiler 
(.xls file), or GeneSpring MS (.txt file).

• Copy and paste a compound list from MassHunter Qualitative Analysis.

• Type in masses and retention times directly into the table.
4 Select or enter the Type of mass (normally Neutral for Batch Search) and Mass 

tolerance, in ppm or mDa. 
5 Select Radical ion search mode options as follows: 

• Include neutrals is normally always selected.

• Select Include anions and/or Include cations if you also want to consider 
those few chemicals that don't pick up or lose a proton to ionize. 

6 Select one of the following options for Retention times:

Option Meaning Application

Ignore Don’t consider retention time even 
if it is present in the list

When searching the master Pesticide 
database or a custom database without 
retention time data.
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7 Initiate the search in any of the following ways: 

• Click the Find Compounds button on the toolbar.

• Select Find Compounds from the Database menu.

• Press the F5 key. 
8 When the search is complete, the number of hits for each mass appears in the 

Hits column of the mass list, and the list is automatically sorted to show the 
masses with the most hits at the top of the list. To sort the list by a different 
criterion, click the heading for the column of interest (Mass or RT). 
Masses with conflicting hits are shown in red text in the Mass List table.

9 Click on a row in the Mass List table to display the compounds found for that 
mass in the Search Results table in the lower part of the window. For more 
information on viewing batch search results, see “To view batch search results” 
on page 18. 

10 Select and view the best compound hit for each mass as described in “To view 
batch summary results” on page 19.

Optional Use retention time information to 
rank a compound higher if its 
retention time matches with the 
observed retention time.

Any. Select this option if you plan to update 
retention times in a custom database from 
the mass list as described in “To update 
retention time data” on page 25.

Required Consider only compounds that 
match the specified retention time 
range.

When searching a database that contains 
retention time information for compounds.
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To view batch search results

1 Do a search on the Batch Search tab as described in “To find compounds from a 
mass list” on page 16.

2 When the search is complete, the number of hits for each mass appears in the 
Hits column of the mass list, and the list is automatically sorted to show the 
masses with the most hits at the top of the list. To sort the list by a different 
criterion, click the heading for the column of interest (Mass or RT). Masses with 
conflicting hits are shown in red text in the Mass List table.

3 Click on a row in the Mass List table to display the compounds found for that 
mass in the Search Results table in the lower part of the window. 

 Tip For ease of reviewing results, use the F4 key to scroll down the Mass List and the 
Shift+F4 keys to scroll back up. The information in the Results table will be updated 
as you scroll through the mass list. 
4 (Optional) Change how the batch search results are displayed as described in 

“To change how data is displayed in the Results table” on page 14. 
5 See “To view batch summary results” on page 19 for information on selecting 

and viewing the best compound hit for each mass.
6 Click on a compound in the Results table to view its structure information in 

the Structures area on the right side of the window, if the structure is available 
in the database. 

7 Click on the Edit Compounds tab to edit information for custom databases that 
allow editing, as described in “To edit a custom database” on page 23.

8 To print batch results, see “To print search results” on page 15.
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To view batch summary results

1 Do a search on the Batch Search tab as described in “To find compounds from a 
mass list” on page 16.

2 Click on a row in the Mass List table to display the compounds found for that 
mass in the Search Results table in the lower part of the window. Masses with 
conflicting hits are shown in red text in the Mass List table.

3 Review the entries marked in the Best column for each mass and if necessary, 
edit the Batch Search Results table to select the best compound hit by marking 
the desired row (compound). You can also clear the box for the selected hit to 
ignore all the results for that compound.

4 Click the Batch Summary tab to view only the best hits from the Batch Search 
Results table. Compounds with conflicting mass hits are shown in red text in 
the results table.

5 (Optional) Change how the batch summary results are displayed as described 
in “To change how data is displayed in the Results table” on page 14. 

6 Click on a compound in the Results table to view its structure information in 
the Structures area on the right side of the window, if the structure is available 
in the database. 

7 Click on the Edit Compounds tab to edit information for custom databases that 
allow editing, as described in “To edit a custom database” on page 23.

8 To export batch summary results, see “To export batch summary results” on 
page 20.

9 To print batch summary results, see “To print search results” on page 15.
10 (Optional) For a custom database with editing enabled, you can update 

retention times in the database for the compounds shown in the Batch 
Summary Results table. See “To update retention time data” on page 25.
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To export batch summary results

1 Do a batch search as described in “To find compounds from a mass list” on 
page 16.

2 Select and view the best compound hit for each mass as described in “To view 
batch summary results” on page 19, or clear the box for the selected hit to 
ignore all the results for that compound.

3 (Optional) Change the display of data in the Batch Summary tab as described 
in “To change how data is displayed in the Results table” on page 14. 

4 Open the Export Results dialog box in any of the following ways: 

• Select Export Results from the File menu.

• Click the  button on the toolbar.

• Right-click in the results table and select Export Results from the shortcut 
menu in the Batch Summary results table.

5 Click the Select button if you wish to specify a different file name, location, or 
file type for the export file. Otherwise the following default file name, location, 
and format is used: 

• If the mass list was opened from a file, the export file name is: 
<massListFileName>-<timestampInSecs>.txt

• If you entered the mass list manually, the export file name is:  
MassList-<timestampInSecs>.txt

• The default location for the export file is MassHunter\PCD\Results. 

• The default output file format is .TXT (tab-separated values), but you can 
select .CSV (comma-separated values) instead.

6 Select one or more of the following types of information to include in the report: 
Search parameters, Results, and Unmatched masses (available only if the 
Results checkbox is marked).

7 Mark the Open results file after exporting option to open the batch summary 
results file automatically in the associated application. 

8 Click OK to output the results. 
9 The results will open in the associated application such as Excel if you selected 

the Open results file option in Step 7. Otherwise open the exported results file 
in your application of choice at a later time.

NOTE When a .csv file is opened in Excel, the Text Import Wizard may be displayed automatically. 
If so, follow the prompts to specify the proper delimiter for your file, e.g. comma or tab. 

If the wizard is not displayed automatically, all the values for each row may appear in the 
first column. To split the text into columns, select the first column (A), then start the wizard 
by selecting Text to Columns on the Data tab, in the Data Tools group.
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Database operations

The following operations apply to both Master and custom databases and are 
described in the following pages:

• “To open a database” (below)

• “To back up a database” (below)

• “To view database information” on page 22

To open a database

1 Open the Open Database dialog box in either of the following ways:

• Select Open Database from the File menu. 

• Click the  button on the toolbar.
2 Select the database of interest (.mtl file extension) and click the Open button.

The following database files are supplied with the software:

• Pesticides.mtl - the master Pesticide database. This database cannot be edited, 
but can be copied to create a custom database that can be edited. See “To 
create a custom database” on page 23.

• Empty.mtl - an empty master database, which can be used to create a custom 
database for importing compounds. To create a database and import 
compounds, see “To create a custom database” on page 23 and “To import 
compounds” on page 26.

To back up a database

1 Select Backup Database from the File menu. 
2 Select a folder for the backup file or accept the default folder, which is: 

MassHunter\databases\Archive 

3 Type in a file name for the backup file or accept the default file name, which is 
in the form: 
<dbname>.<yyyy.mm.dd>.mtl 

where dbname is the name of the current database, yyyy is the current year, mm 
is the current month, and dd is the current day of the month. 

4 Click the Save button. A backup copy of the database is created using the 
specified file name and location.
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To view database information

1 Select Database Information from the Database menu. 
2 View the following information about the database: 

• Database file name 

• The number of compounds (entries) in the database 

• Type (Master or User) 

• Edit allowed (Yes or No) 

• Last modified timestamp

• Version number 

• Description - the description can be edited if the current database is a 
custom database with editing enabled.

3 Click the Close button to close the Database Information dialog box.
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Custom database operations

The following operations apply only to custom databases and are described in the 
following pages:

• “To create a custom database” (below)

• “To edit a custom database” (below). This includes adding and removing 
compounds.

• “To update retention time data” on page 25

• “To import compounds” on page 26

To create a custom database

1 Select New Database from the File menu or click the  button on the 
toolbar.

2 Do the following steps on the New Database dialog box: 

a Select a starting database for the new database. Use Empty.mtl if you want to 
create an empty database for importing compounds.

b Type in a name for the new database. 

c Enter a description for the new database. 

d Click the Create button to create the new database. 
The new database becomes the current working database and is automatically 
enabled for editing. 

To edit a custom database

Use this procedure to edit information for compounds, to add a new compound, or 
to remove a compound.
1 Open the custom database of interest. 
2 Enable editing by marking Allow Editing on the Database menu.
3 Do a search using either of the following:

• “To find compounds” on page 12.

• “To find compounds from a mass list” on page 16.
4 When the search is complete, click the Edit Compounds tab.
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5 To update information for a particular compound:

a Select the compound of interest by clicking on it in the Search Results table. 
Information for the selected compound is displayed in the Edit Compounds 
tab.

b Update information on the left side of the Edit Compounds tab, such as 
Name, Mass, RT, Formula, CAS ID, and Radical ion type.

c Update structure information if desired in either of the following ways:

• Click on the MOL Text tab and paste in MOL file text that you have copied 
from a molecular drawing tool (Ctrl+V), or 

• Click the  button in the Molecule area to open a .MOL file.

d Click the Update Selected button. The information for the compound is 
updated in the database and the information you entered in Step 5b is 
reflected in the Results table.

6 To add a new compound to the database:

a Click the Add New button. A new compound is created in the database with 
a mass of 0 named “New Compound” and the new compound is displayed at 
the end of the Results table.

b Enter or change information for the new compound as described in Step 5 
above.

c Click the Update Selected button. The information you entered for the new 
compound is updated in the database and the information is reflected in the 
Results table.

Alternate method 
to add a new 

compound

Enter information for a new compound on the left side of the Edit 
Compounds tab, such as Name, Mass, RT, Formula, CAS ID, and Radical ion 
type, then click the Save As New button. A new compound is created in the 
database using the specified values. The new compound is displayed at the end 
of the Results table. 

7 To remove a compound from the database:

a Select the compound of interest by clicking on it in the Search Results table.

b Click the Delete Selected button.
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To update retention time data

1 Open the custom database of interest. Be sure that editing is enabled by 
marking Allow Editing on the Database menu.

2 Click on the Batch Search tab.
3 Enter a mass list in one of the following ways: 

• Click the File button to the left of the mass list table to open a mass list file 
output by MassHunter Workstation Qualitative Analysis (.csv or .txt file), 
Mass Profiler (.xls file), or GeneSpring MS (.txt file).

• Copy and paste a compound list from Qualitative Analysis.

• Type in masses and retention times directly into the table.

4 Select one of the following options for Retention times:

• Optional - Use this option to search a database that either has no retention 
time information or has retention times missing for some compounds that 
you now want to update. 

• Required - Use this option if you only want to identify and update those 
compounds that already have retention time information in the database. 
Specify an RT tolerance value in minutes as well.

5 Set other search criteria if desired as described in “To find compounds from a 
mass list” on page 16.

6 Initiate the search in any of the following ways: 

• Click the Find Compounds button on the toolbar.

• Select Find Compounds from the Database menu.

• Press the F5 key.
7 When the search is complete, the number of hits for each mass appears in the 

Hits column of the mass list, and the list is automatically sorted to show the 
masses with the most hits at the top of the list. To sort the list by a different 
criterion, click the heading for the column of interest (Mass or RT). 
Masses with conflicting hits are shown in red text in the Mass List table. 

8 Click on a row in the Mass List table to display the compounds found for that 
mass in the Search Results table in the lower part of the window. For more 
information on viewing batch search results, see “To view batch search results” 
on page 18. 

NOTE Every mass in the mass list must have a retention time value for this procedure.
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9 Select and view the best compound hit for each mass as described in “To view 
batch summary results” on page 19 or clear the box for the selected hit to ignore 
that compound.

10 Click the Apply Retention Times button to apply retention times from the Mass 
List in the Batch Search tab for each of the compounds listed in the Batch 
Summary table.

To import compounds

Use the following procedure to import compounds into a custom database or to 
create a custom database from a compound list created by another application. If 
you start with an empty database, then you are essentially creating a custom 
database from the imported compounds.
1 Prepare the import file. The format required for the import file is described in 

the online help. The .CSV or .TXT file can be created in any of the following ways:

• Exported from Personal Compound Database software as described in “To 
export batch summary results” on page 20.

• Exported from another application such as Agilent Mass Profiler or 
GeneSpring MS software.

• Manually in Excel.
2 Open the custom database of interest or create a new database.

3 Enable editing on this database by marking Allow Editing on the Database 
menu.

4 Select Import Compounds from the File menu.
5 Select the .CSV or .TXT file prepared in Step 1 that contains the compounds of 

interest, then click the Open button.
6 To view the new compounds in the database, do a search on the Single Search 

tab with no criteria or criteria that you know will find the compounds of 
interest. The compounds will be listed in the Search Results table in the lower 
part of the window. 

NOTE All conflicting results must be resolved before retention time data can be updated.

NOTE You can create a new database for importing compounds from Empty.mtl as described in 
“To create a custom database” on page 23.
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7 Compounds that were not imported due to problems with the input file are 
saved in the file <ImportFileName>-ImportLog.csv, where <ImportFileName> is the 
name of the import file selected in Step 5. Edit this log file to fix the problems, 
then import the corrected file. 

8 (Optional) See “To edit a custom database” on page 23 if you want to change 
information for the imported compounds. 

NOTE The mass is calculated from the formula, unless the difference is > 0.0001 Da. In that case, 
the Mass and Formula values will be as read from the input file, and those compounds will 
be added to the file: <ImportFileName>-MassErrorsLog.csv, where <ImportFileName> 
is the name of the import file selected in Step 5. The information in the log file can be used 
to determine the correct Formula or Mass. Typically errors will occur when 1) the mass 
value was the mass from the spectrum and not a neutral mass, or 2) the formula contained 
the adduct (such as Cl).
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Familiarization Exercises

Exercise 1. Search for compounds in a database

In this exercise, you will search the master Pesticide database and review the 
search results.

Steps Detailed Instructions Comments

1 Open the master Pesticide 
database.

a Select Open Database from the File 
menu, or click the  button on the 
toolbar.

b Select the Pesticides.mtl file, and click 
the Open button.

Skip this step if the master Pesticide 
database is already open.

2 Click on the Single Search tab.

3 Leave the search fields blank. Be sure that the Require checkbox for 
Retention time is cleared, since the 
master Pesticide database does not 
contain retention time information.

This will return the contents of the 
entire database. See “To find 
compounds” on page 12 for a 
discussion of search parameters to 
narrow your search.

4 Click the Find Compounds button 
on the toolbar to begin searching.

You can also start the search in either 
of the following ways:
• Select Find Compounds from the 

Database menu.
• Press the F5 key. 

5 Review the search results in the 
table in the lower half of the 
window.

The results are sorted from low mass 
to high mass.

6 View structure information for a 
selected compound.

a Click on a compound in the Results 
table. Its structure is displayed in the 
Structures area on the right side of the 
window.

b Click on the MOL Text tab to view the 
text version of the structure. 

c Click the  button to view a larger 
image of the structure.

The structure for the selected 
compound is displayed if it is available 
in the database.

7 Sort the table by name. Click the heading of the Name column. 
Click it again to sort by name in the 
opposite order.

Clicking on any column heading will 
sort the table according to the values 
in that column.
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8 Reorder the columns in the table. a Drag a column heading to a different 
position. 

b Repeat until the desired order is 
achieved. 

9 Resize a column. You can resize columns in either of the 
following ways:
• Double-click on the right column 

divider in the heading of the column of 
interest to resize the column to fit the 
information contained in it.

• Drag the separator between column 
headings to the right or left until the 
column of interest is the desired width.

10 Change which columns of 
information are displayed in the 
table.

a Right-click in the table and select 
Add/Remove Columns from the 
shortcut menu. 

b Move the items of information that you 
want to display from the Available 
columns list into the Show these 
columns list using the Add-> button.

c Move the items of information that you 
don’t want to display out of the Show 
these columns list into the Available 
columns list using the <-Remove 
button.

d Click OK. 

Alternate Methods:
• You can also open the Add/Remove 

Columns dialog box by selecting 
Add/Remove Columns from the 
View menu.

• You can move individual items 
between the two lists by 
double-clicking them.

Note that the original column layout 
can be restored at anytime by 
selecting Restore to Default Columns 
from the View menu.

11 Print results. a To print only selected results, highlight 
those rows in the Results table using 
Ctrl+click or Shift+click, then select 
Only highlighted rows as one of the 
print options in Step 11c below.

b Click the  button on the toolbar to 
open the Print Results dialog box.

c Select print options. For a discussion 
of print options, see “To print search 
results” on page 15.

d Click OK. If you selected the Print 
Preview option, review the report in 
the Print Preview window, then click 
the  button to print it.

You can also open the Print Results 
dialog box in either of the following 
ways: 
• Select Print Results from the File 

menu
• Right-click in the results table and 

select Print Results from the 
shortcut menu.

Steps Detailed Instructions Comments
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Exercise 2. Batch search from a mass list

In this exercise, you will search the master Pesticide database using an imported 
mass list.

Steps Detailed Instructions Comments

1 Open the master Pesticide 
database.

a Select Open Database from the File 
menu, or click the  button on the 
toolbar.

b Select the Pesticides.mtl file, and click 
the Open button.

Skip this step if the master Pesticide 
database is already open, as it will be 
after Exercise 1.

2 Click on the Batch Search tab.

3 Open a mass list. a Click the File button to the left of the 
mass list table.

b Select the pest_compounds.txt mass 
list file in the MassHunter\PCD\Mass 
List Files folder. 

c Click the Open button.

• Mass lists can also be 
copy-and-pasted into Personal 
Compound Database software from 
Qualitative Analysis.

• See online help in MassHunter 
Qualitative Analysis for instructions 
on how to output a mass list.

4 Set the search parameters. a Select the Neutral Masses option and 
set the Mass tolerance value to 10 
ppm.

b Mark Ignore for Retention times.
c Mark only the Include neutrals option 

for Radical ion search mode.

The master Pesticide database does not 
include retention times.

5 Click the Find Compounds button on 
the toolbar to begin searching.

You can also start the search in either of 
the following ways:
• Select Find Compounds from the 

Database menu.
• Press the F5 key.

6 Review search results. When the search is complete, the number 
of hits for each mass appears in the Hits 
column of the mass list, and the list is 
automatically sorted to show the masses 
with the most hits at the top of the list. 
Masses with conflicting hits are shown in 
red text in the Mass List table. See Figure 1 
on page 32.

To sort the mass list by a different 
criterion, click the heading for the 
column of interest (Mass or RT).
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7 View hits for selected masses. Click on a row in the Mass List table to 
display the compounds found for that mass 
in the Batch Search Results table in the 
lower part of the window. 

For ease of reviewing results, use the 
F4 key to scroll down the Mass List and 
the Shift+F4 keys to scroll back up. The 
information in the Results table will be 
updated as you scroll through the mass 
list.
The batch search results table can be 
resorted as described in “To change 
how data is displayed in the Results 
table” on page 14.

8 Review the entries marked in the 
Best column for each mass and edit 
the Batch Search Results table to 
select the best compound hit for a 
particular mass.

Mark the Best column for the row 
(compound) you believe is the best 
compound hit for each mass. In many 
cases, this will be the one already selected 
by the software.

You can also clear the box for the 
selected hit to ignore that mass.

9 View the best hit results. Click the Batch Summary tab. The Best hit 
for each mass is shown in the Batch 
Summary table in the lower part of the 
window. See Figure 2 on page 33.

Compounds with conflicting mass hits 
are shown in red text in the results 
table.
The batch summary results table can be 
resorted as described in “To change 
how data is displayed in the Results 
table” on page 14.

10 Export batch summary results. a Click the  button on the toolbar to 
open the Export Results dialog box.

b Select the options to include Search 
parameters, Results, and Unmatched 
masses.

c Mark the Open results file after 
exporting option.

d Click OK to output the results. 
The results will open in the associated 
application such as Excel.  
The following export file is created in the 
MassHunter\PCD\Results folder: 
pest_compounds-<timestamp>.txt

You can also open the Export Results 
dialog box in either of the following 
ways: 
• Select Export Results from the File 

menu.
• Right-click in the Batch Summary 

results table and select Export 
Results from the shortcut menu. 

You can select a different file name, 
location or type as described in “To 
export batch summary results” on 
page 20.

Steps Detailed Instructions Comments
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Figure 1 Results of Batch Search
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Figure 2 Batch Summary Results
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Exercise 3. Create a custom database

In this exercise, you will create a custom database that is a subset of the master 
Pesticide database.

 

Steps Detailed Instructions Comments

1 Open the New Database dialog 
box.

Select New Database from the File menu, 
or click the  button on the toolbar.

2 Create the new database. a Select Pesticides as the starting 
database for the new database.

b Type in a name for the new database, 
e.g. Pesticides_Subset.

c Enter a description for the new 
database, such as “My database”. 

d Click the Create button to create the 
new database. 

The new database becomes the 
current working database and is 
automatically enabled for editing. 

3 Edit the database. See “Exercise 4. Edit a custom database”.
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Exercise 4. Edit a custom database

In this exercise, you will edit the custom database that you created in 
Exercise 3.

 

Steps Detailed Instructions Comments

1 Open the custom database you 
created in Exercise 3, if it is not 
already open.

a Select Open Database from the File 
menu, or click the  button on the 
toolbar.

b Select the Pesticides_Subset.mtl file, 
and click the Open button.

Skip this step if the custom database 
is already open, as it will be if you just 
completed Exercise 3.

2 Verify that editing is allowed for 
this database.

Open the Database menu and verify that 
there is a check mark next to Allow 
Editing.

 

3 Do a search. a Click the Single Search tab.
b Click the Find Compounds button on 

the toolbar to start the search. The 
search results appear in the table in 
the lower half of the window.

See “Exercise 1. Search for 
compounds in a database” on page 28 
for more information on the available 
search criteria. This search returns all 
neutral mass compounds in the 
database.

4 Click the Edit Compounds tab.

5 Update information for a particular 
compound.

a Select the compound of interest by 
clicking on it in the Search Results 
table. 

b Update information on the left side of 
the Edit Compounds tab, such as 
Mass, RT, Formula, Name, CAS ID, and 
Radical ion type.

c Click the Update Selected button to 
apply the changes to the database. 

Information for the selected compound 
is displayed in the Edit Compounds 
tab.

The updated information will be 
changed in the database and reflected 
in the Results table. 

6 Update structure information for a 
particular compound.

a  Select the compound of interest by 
clicking on it in the Search Results 
table. 

b Click the  button in the 
Molecule area to open a .MOL file. 

c Click the Update Selected button. The 
information you entered will be 
changed in the database.

You can also update structure 
information for a selected compound 
by clicking on the MOL Text tab and 
pasting in MOL file text that you 
copied from a molecular drawing tool 
(Ctrl+V).
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7 Add a new compound to the 
database.

a Click the Add New button.  
A new compound is created in the 
database with a mass of 0 named 
“New Compound”, and the new 
compound is displayed at the end of 
the Results table.

b Enter or change information for the 
new compound as described in Step 5 
above.

c Click the Update Selected button.  
The information you entered for the 
new compound is updated in the 
database and the information is 
reflected in the Results table.

Alternate method: 
a Enter information for a new 

compound on the left side of the 
Edit Compounds tab, such as Mass, 
RT, Formula, Name, and Radical ion 
type.

b Click the Save As New button.  
A new compound is created in the 
database using the specified 
values. The new compound is 
displayed at the end of the Results 
table.

8 Remove a compound from the 
database.

a Select the compound of interest by 
clicking on it in the Search Results 
table. 

b Click the Delete Selected button. 

The selected compound is removed 
from the database.

9 Add retention times to the 
database as described in Exercise 
5.

Steps Detailed Instructions Comments
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Exercise 5. Add retention times to a database

In this exercise, you will add retention times to the custom database 
created in Exercise 3.

 

Steps Detailed Instructions Comments

1 Open the custom database you 
created in Exercise 3, if it is not 
already open.

a Select Open Database from the File 
menu, or click the  button on the 
toolbar.

b Select the Pesticides_Subset.mtl file, 
and click the Open button.

None of the pesticides in this example 
database have retention times.

2 Enable editing on this database. Open the Database menu and mark Allow 
Editing.

3 Click the Batch Search tab.

4 Open a mass list file that contains 
retention time information for the 
masses.

a Click the File button to the left of the 
mass list table.

b Select pest_compounds.txt in the 
MassHunter\PCD\Mass List Files 
folder.

c Click the Open button.

• Each mass in the mass list must 
have an associated retention time 
value.

5 Set the search parameters. a Set the Mass tolerance to 100 ppm.
b Set the RT tolerance to 1 minute.
c Mark Retention times Optional as 

shown below:

6 Start the search. Click the Find Compounds button on the 
toolbar. 

The results are shown in Figure 3.

7 Resolve conflicting hits. a Click on a row in red in the Mass List 
table.

b Mark the Best column for the desired 
row (compound) or clear the box for 
the selected hit to ignore the mass.

All conflicting results must be resolved 
before retention time data can be 
updated.
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Figure 3 Batch Search Results with Retention Time Optional

8 Click the Batch Summary tab. See Figure 4.

9 Update retention times in the 
database from the current mass 
list.

Click the Apply Retention Times button.
Note that this button is unavailable until 
all conflicting hits are resolved as 
described in Step 7.

Retention time information is updated 
in the database for each of the 
compounds listed in the Batch 
Summary table. See Figure 5.

Steps Detailed Instructions Comments
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Figure 4 Batch Summary Results with Retention Time Optional (before updating)
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Figure 5 Batch Summary Results with Retention Times Updated
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